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ABSTRAK 

Perkembangan industri kelapa sawit dewasa ini semakin pesat. Salah satu hasil industri kelapa sawit 

yang kerap menjadi limbah adalah Tandan Kosong Kelapa Sawit (TKKS). TKKS ini dapat diolah 

menjadi serat yang akhirnya dapat dimanfaatkan sebagai material engineering. Tujuan penelitian ini 

adalah untuk menganalisa mutu fisik dan respon mekanik yang diterima genteng komposit dan 

genteng komersil akibat beban impak jatuh bebas. Spesmen yang akan di uji berukuran 380 × 235 × 

20 mm. kekuatan mekanik material diperoleh dengan cara melakukan pengujian yaitu menggunakan 

alat uji impak jatuh bebas. Dari hasil analisa mutu fisik, berat genteng dapat direduksi hingga 44,89% 

dan memiliki berat rata-rata 1,518 kg, rata-rata area porositas pada genteng komposit adalah 55,85%, 

dan hasil uji rembesan air tidak ditemukan adanya kerusakan struktur dan rembesan air, namun 

penyerapan air hingga 62%. Pada pengujian impak jatuh bebas diperoleh gaya impak yang diterima 

genteng komposit pada ketinggian 0,5 m dan 1 m adalah 106,0461 N dan 132,5331 N. Sedangkan 

pada genteng komersil dengan ketinggian yang sama diperoleh 150,2892 N dan 167,9472 N. Pola 

kerusakan yang terjadi pada genteng komposit adalah patah matriks namun belum mengalami 

kegagalan pada serat, sedangkan pada genteng komersil mengalami patah matriks  dan terpisah 

menjadi beberapa bagian. Perbedaan pola kerusakan ini disebabkan karena genteng komposit memiliki 

struktur yang berbusa dan memiliki penguat serat yang meredam tegangan yang masuk pada specimen 

dan membuat sifat genteng menjadi kurang getas daripada genteng komersil. 

Kata kunci : Limbah Tandan Kosong Kelapa Sawit, Material Engineering, Concrete Foam, Beban 

Impak Jatuh Bebas, Genteng Komposit. 

1. PENDAHULUAN

Genteng sudah sangat umum digunakan di berbagai belahan dunia sebagai pelindung

bagian dalam bangunan dari pengaruh cuaca. Diperkirakan genteng sudah digunakan dalam 

konstruksi bangunan sejak 3000-an tahun sebelum masehi. Genteng tidak hanya berfungsi 

melindungi bagian dalam bangunan dari hujan dan panas, genteng juga harus mampu 

menahan beban flexure dan dinamik. Selain itu genteng juga harus mampu meredam 

kebisingan yang ditimbulkan akibat rain drop, tidak mudah terdeformasi akibat perubahan 

suhu, serta memiliki bobot yang tidak terlalu berat..  

Tandan kosong kelapa sawit (TKKS) merupakan salah satu limbah terbesar yang dihasilkan 

dari pengolahan kelapa sawit. TKKS yang dihasilkan dapat mencapai 230 kg per 1 ton 

pengolahan tandan buah segar [1]. 

Beton memiliki sifat getas yang tidak menguntungkan, yang membuat beton langsung 

rusak jika dikenai tegangan impak [2]. Batako ringan dari bahan concrete foam yang 

diperkuat serat TKKS memiliki modulus elastisitas 5,82 GPa jauh lebih mampu menyerap 

tegangan impak dibandingkan batako ringan di pasaran [3]. Penulis akan mencoba proses 

pembuatan genteng komposit dengan menggunakan bahan concrete foam yang diperkuat oleh 

serat TKKS. 

1. Batasan Masalah
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Pembuatan genteng komposit menggunakan busa dengan memanfaatkan foam generator 

untuk membuat busa secara terpisah. Setelah busa terbentuk baru dimasukkan ke dalam 

adonan beton dan selanjutnya ke dalam cetakan. 

2. Tujuan Penelitian

Dari uraian latar belakang dan rumusan masalah  pada pendahuluan maka tujuan umum dari 

penelitian ini adalah untuk membandingkan ketahanan genteng komposit berbahan  concrete 

foam yang diperkuat serat TKKS dengan genteng komersil terhadap impak dengan metode 

impak jatuh bebas secara eksperimental. 

3. Manfaat Penelitian

Manfaat penelitian ini adalah untuk memberikan masukan kepada dunia pendidikan dan dunia 

industri tentang produk genteng komposit dari material concrete foam yang diperkuat serat 

TKKS secara fisis dan mekanis. Selain itu juga untuk memanfaatkan limbah TKKS menjadi 

sebuah produk yang memiliki nilai guna yang lebih tinggi. 

2. TINJAUAN PUSTAKA

Bahan Komposit 

Komposit adalah campuran dua material atau lebih yang dicampur secara makroskopik untuk 

menghasilkan suatu material baru. Artinya penggabungan sifat-sifat unggul dari pembentuk 

material masih terlihat nyata [3]. 

Genteng Beton 

Genteng beton atau genteng semen adalah unsur bangunan yang dipergunakan untuk atap 

yang dibuat dari beton dan dibentuk sedemikian rupa serta berukuran tertentu, dibuat dengan 

cara mencampur pasir dan semen ditambah dengan air, kemudian diaduk sampai homogen 

lalu dicetak, selain semen dan pasir, sebagai bahan pembuatan genteng beton dapat juga 

ditambahkan kapur 

 Material Komposit Concrete Foam 

Pada komposit concrete foam, materialnya terdiri dari semen, pasir, air, blowing agent dan 

serat TKKS. Blowing agent yang digunakan dalam penelitian ini adalah surfaktan. 

Gerak Lurus 

Perpindahan adalah sebuah perubahan kedudukan ini merupakan besaran vektor yang 

memiliki jarak dan arah. Percepatan dapat didefinisikan sebagai laju perubahan kedudukan 

terhadap waktu. Ini juga merupakan besaran vektor yang memiliki  jarak, arah, dan waktu.  

hgV .2= ……………………..…(2.1) 

dimana:    

v = Kecepatan benda jatuh bebas, (m/s). 

g = Gaya grafitasi, (m/s2). 

h = ketinggian jatuh benda, ( m). 

. 

Momentum dan Impuls 
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Momentum dan Impuls adalah sebagai satu kesatuan karena momentum dan Impuls dua 

besaran yang setara. Dua besaran dikatakan setara seperti momentum dan Impuls bila 

memiliki satuan Sistem Internasional (SI) sama atau juga dimensi sama. 

Gambar 2.1 Grafik gaya vs waktu 

vmM .= ……………………(2.2)

dimana:  

M  = momentum, (kg.m/s). 

m  =  massa, (kg). 

v = kecepatan, (ms-2). 

Impuls adalah lonjakan gaya tiba-tiba pada selang waktu tertentu yang merupakan 

hasil kali gaya dengan selang waktu yang diperlukan. Grafik implus dideskripsikan seperti 

pada gambar 2.1,  dan dapat dinyatakan dalam persamaan (2.3). 

tFI .= ………………………(2.3)

Dimana:  

I =  implus 

F = gaya (N)  

t = waktu (s) 

Tegangan 

Besarnya tegangan menunjukkan apakah bahan tersebut mampu menahan perubahan bentuk 

sebelum patah. Makin besar tegangan suatu bahan maka bahan itu mudah dibentuk. Maka, 

rumus tegangan adalah:  

σ =
F

Ao
………………………...(2.4) 

Dimana: 

σ = Tegangan (N/m2) 

F = gaya (Newton)  

Ao = luas penampang awal (m2) 

Porositas 

Porositas adalah besarnya persentase ruang- ruang kosong atau besarnya kadar pori yang 

terdapat pada beton dan merupakan salah satu faktor utama yang mempengaruhi kekuatan 

beton. Pori-pori beton biasanya berisi udara atau berisi air yang saling berhubungan dan 

dinamakan dengan kapiler beton. Kapiler beton akan tetap ada walaupun air yang digunakan 

telah menguap, sehingga kapiler ini akan mengurangi kepadatan beton yang dihasilkan. 

Dengan bertambahnya volume pori maka nilai porositas juga akan semakin meningkat dan hal 

ini memberikan pengaruh buruk terhadap kekuatan beton [11]. 
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3. METODOLOGI PENELITIAN

Tempat dan Waktu 

Penelitian ini dilaksanakan dalam beberapa tahapan , yaitu seperti diuraikan pada Tabel 3.1. 

Tabel 3.1. Lokasi dan aktivitas penelitian 

No. Aktifitas Lokasi Penelitian 

1. Pembuatan

serat TKKS

Pusat Riset IMPak 

dan Keretakan, Dept. 

Teknik Mesin, FT-

USU. 

2. Pembuatan

genteng

komposit

dicampur

serat TKKS

Pusat Riset IMPak 

dan Keretakan, Dept. 

Teknik Mesin, FT-

USU. 

3. Uji impak 

jatuh bebas

Pusat Riset IMPak 

dan Keretakan, Dept. 

Teknik Mesin, FT-

USU. 

4. Analisa data

olah data

Alat dan Bahan 

Beberapa alat yang digunakan dalam penelitian ini adalah sebagai berikut: 

1. Alat uji impak jatuh bebas

2. Horizontal shaft mixer

3. Foam generator

4. Timbangan digital

5. Wadah adukan

6. Mesin penghalus serat

7. Cetakan

8. Gelas ukur

Bahan-bahan yang akan digunakan dalam penelitian ini adalah: 

1. Pasir

2. Semen

3. Air bersih

4. Foaming agent

5. Serat TKKS

Geometri Spesimen 

Geometri spesimen akan diuji impak jatuh bebas seperti ditunjukkan pada Gambar 3.1. 

Gambar 3.1 Geometri spesimen genteng 

Proses Pembuatan Genteng Komposit 
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Gambar 3.2 Diagram alir proses pembuatan genteng komposit 

Alat Cetak Genteng Komposit 

Alat cetakan terbuat dari fiberglass dengan ukuran 380 × 235 × 20 mm seperti diperlihatkan 

pada Gambar 3.3. 

Gambar 3.3 Alat cetak genteng komposit 

Analisa Hasil Produk 

1. Reduksi Berat

Prosedur pengukuran: 

1. Ambil 5 buah sampel masing-masing genteng komposit dan genteng komersil.

2. Timbang sampel dan catat hasilnya.

2. Makrostruktur

Prosedur pengukuran menggunakan software ImageJ untuk mendapatkan jumlah dan besar 

butir udara adalah sebagai berikut: 

1. Klik start menu dan pilih ImageJ

2. Klik File → Open → Pilih gambar yang sudah dipotong dengan software Adobe

Photoshop.

3. Klik icon Line dan buatlah garis secara horizontal dari sisi kiri ke sisi kanan.
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4. Klik Analyze → Set Scale →Known distance = 10 → Unit of length adalah mm →OK.

5. Klik Image → Adjust → Treshold → Treshold color B&W → Close window.

6. Klik Analyze → Analyze particles → Pada Show pilih Outlines → Centang Display result

→ OK.

7. Simpan file dalam format Ms. Excel.

3. Uji Rembesan Air

Pengujian kemampuan kedap air pada genteng pada penelitian ini mengacu pada standar SNI-

0096-2007 dengan skema set-up uji seperti diperlihatkan pada Gambar 3.3 [10]. 

Gambar 3.3 Set-up uji rembesan air 

 Langkah-langkah pengujian permeabilitas genteng adalah sebagai berikut: 

1. Siapkan genteng komposit sebanyak 3 buah.

2. Letakkan genteng pada penyangga.

3. Lapisi sekeliling benda uji dengan pasta penambal (seal).

4. Tuang air keatas genteng hingga ketinggian 15 mm.

5. Biarkan selama 20 jam ± 5 menit dalam suhu ruangan 30oC dan kelembaban relatif 40%.

6. Catat ada atau tidak adanya tetesan air yang jatuh pada permukaan cermin.

Setup Pengujian 

Metode pengujian impak jatuh bebas yang akan digunakan adalah drop weight. Gambar setup 

seperti ditunjukkan pada gambar 3.4. 

Gambar 3.4. Setup pengujian 

Prosedur Pengujian 

Sebelum dilakukan pengujian terlebih dahulu dilakukan persiapan terhadap specimen yaitu: 

1

2 

3

4 



Ed
is

i C
et

ak
 Ju

rn
al

 D
in

am
is

, D
es

em
be

r 2
01

8 
(I

SS
N

: 0
21

6-
74

92
) Jurnal Dinamis, Volume.6, No.4 Desember 2018      ISSN  0216-7492 

92 

1. Letakkan impaktor yang berbentuk plat datar berukuran 385 × 235 mm diatas permukaan

genteng yang akan diuji.

2. Amati apakah ada  ruang kosong pada permukaan yang seharusnya bersentuhan.

3. Jika ada ruang kosong, maka cari bagian yang tidak rata dan lakukan pengamplasan atau

dikikir permukaan yang tidak rata tersebut hingga permukaan plat dapat bersentuhan

dengan area impak  yang diinginkan.

Langkah-langkah pengujian: 

1. Letakkan sampel uji yang akan dilakukan pengujian diatas anvil.

2. Pada permukaan plat impaktor yang akan bersentuhan dengan genteng di lapisi dengan cat

warna biru.

3. Tentukan posisi jarak ketinggian jatuh impaktor yang diinginkan, dan pastikan sensor

proximity dalam kondisi aktif.

4. Tekan tombol Start pada software DAQ for Helmet Impact Testing.

5. Setelah jarak ketinggian ditentukan dan memastikan bahwa sensor proximity sudah

berfungsi, specimen uji dan test rig sudah terpasang, maka impaktor siap untuk dijatuhkan

dengan cara melepas tali penahan luncuran impaktor.

6. Tekan tombol STOP setelah beberapa saat impaktor menumbuk specimen pada anvil.

7. Tekan tombol SAVE untuk menyimpan data hasil uji ke dalam file berformat txt, dan akan

tersimpan dalam drive C folder DATAEXP (data experiment).

8. Lalu data hasil pengujian tersebut kita olah dengan menggunakan program software MS-

EXCEL.

Diagram Alir Penelitian 

Diagram alir penelitian ditunjukkan pada Gambar 3.5. 



Ed
is

i C
et

ak
 Ju

rn
al

 D
in

am
is

, D
es

em
be

r 2
01

8 
(I

SS
N

: 0
21

6-
74

92
) Jurnal Dinamis, Volume.6, No.4 Desember 2018      ISSN  0216-7492 

93 

Gambar 3.5 Diagram alir penelitian 

4. Hasil dan Pembahasan

Hasil pembuatan genteng komposit.

Genteng komposit yang dicetak mempunyai ukuran 380 × 235 × 20 mm dapat dilihat pada 

gambar 4.1. 

Gambar  4.1 Hasil cetakan 
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Analisa Hasil Produk 

1. Reduksi Berat

Berat genteng komposit berbahan concrete foam diperkuat serat TKKS berhasil direduksi 

hingga 44,89%. Dan memiliki berat rata-rata 1,518 kg. 

2. Makrostruktur

Hasil produk genteng concrete foam yang dianalisa makrostruktur permukaannya 

menggunakan aplikasi ImageJ dapat dilihat pada Gambar 4.2. 

(a) 

(b) 

Gambar 4.2 (a) Foto makrostruktur permukaan, (b) Foto hasil analisa makrostruktur 

Berdasarkan hasil analisa makrostruktur bagian permukaan genteng komposit yang 

ditunjukkan pada Gambar 4.2 (b), ditemukan 18 titik porositas yang ditunjukkan dengan 

lingkaran merah dengan area 49,42% per 100 mm2 penampang permukaan dan besar 

porositas yang dapat diterima rata-rata 0,008 mm2. 

(a) 
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(b) 

Gambar 4.3 (a) Foto makrostruktur bagian dalam, (b) Foto hasil makrostruktur 

Berdasarkan hasil analisa makrostruktur bagian dalam genteng komposit yang ditunjukkan 

pada Gambar 4.3 (b), ditemukan 40 titik porositas yang ditunjukkan dengan lingkaran merah 

dengan area 62,3% per 100 mm2 penampang permukaan dan besar porositas rata-rata yang 

dapat diterima adalah 0,013 mm2. 

Rata-rata area porositas pada spesimen genteng komposit dapat dilihat pada Tabel 4.2. 

Tabel 4.2 Area porositas 

Penampang Area Porositas (%) 

Permukaan 49,42 

Bagian dalam 62,3 

Rata-Rata 55,86 

Perbedaan porositas bagian dalam dan bagian permukaan cukup besar, hal ini disebabkan 

pada bagian dalamterdapat lebih banyak butir-butir udara yang berasal dari foam, selain itu 

juga disebabkan oleh air yang menempati ruang kosong pada saat dicetak. Air yang telah 

menguap pada masa pengeringan kemudian meninggalkan porositas pada bagian dalam 

spesimen. 

3. Hasil Uji Rembesan air

Dari hasil uji permeabilitas genteng dengan jumlah sampel sebanyak 3 buah yang sudah 

dilapisi dengan cat beton, diperoleh bahwa genteng dari bahan komposit concrete foam 

diperkuat serat TKKS mampu menahan kuantitas air selama 20 jam ± 5 menit tanpa adanya 

kerusakan struktur dan rembesan air.. Tidak ditemukan tetesan air namun genteng menjadi 

lembab akibat penyerapan air. 

Gambar 4.4 Batas air setelah 20 jam 

 10 mm 
Penyusutan 
air 
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Hasil Uji Impak Jatuh Bebas 

1. Ketinggian 0,5 m

Gambar 4.5 Grafik gaya impak ketinggian jatuh 0,5 m. 

Dari Gambar 4.5 dapat dilihat bahwa untuk katerori gaya impak ketinggian 0,5 m untuk 

genteng komposit diperoleh gaya impak spesimen komposit A = 97,2171 N, spesimen 

komposit B dan C = 106,0461 N. sedangkan genteng komersil A = 150,2892 N, spesimen 

genteng komersil B = 159,1182 N. 

(a) 

(b) 

Gambar 4.6 Pola kerusakan spesimen (a) komposit (b) komersil. Ketinggian 0,5 m. 

Berdasarkan pola kerusakan yang ditunjukkan pada Gambar 4.6. spesimen genteng komposit 

mengalami retak pada bagian tengah diakibatkan struktur genteng yang berserat sehingga 

gaya impak yang diserap oleh genteng tersebut tidak terdistribusi dengan baik, selain genteng 

komposit juga mengalami patah matriks dengan kedalaman patahan hingga 5 mm. Sedangkan 

0
20
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120
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0 50
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komersil B
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pada spesimen genteng komersil, stuktur genteng yang padat, kuat dan keras membuat gaya 

impak yang diterima lebih besar dan mengakibatkan patah. 

(a) 

(b) 

Gambar 4.7 Patahan pada area impak ketinggian 0,5 m (a) secara tidak langsung, (b) secara 

langsung 

Pada Gambar 4.7 (b) dapat dilihat retakan pada area titik tengah area impak terdapat banyak 

fiber yang meredam sebagian gelombang impak yang diterima sehingga kegagalan yang 

terjadi pada matriks tidak total dan serat belum mengalami kegagalan. Pada Gambar 4.7 (a) 

distribusi serat masih kurang merata dibanding dengan Gambar 4.7 (b). 

2. Ketinggian 1 m

Gambar 4.8 Grafik gaya impak ketinggian jatuh 1 m. 

Dari Gambar 4.8 dapat dilihat bahwa untuk kategori gaya impak ketinggian 1 m untuk 

genteng komposit diperoleh gaya impak spesimen komposit D dan E = 132,5331 N, spesimen 

komposit F = 141,4602 N. sedangkan genteng komersil C dan D = 167,9472 N. 

0
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Pada grafik gaya impak yang ditunjukkan Gambar 4.8 genteng komersil menerima 

gaya impak 80,68% lebih besar dari genteng komposit pada ketinggian 1 m. 

(a) 

(b) 

Gambar 4.9 Pola kerusakan spesimen (a) komposit (b) komersil, ketinggian 1 m. 

Berdasarkan pola kerusakan yang ditunjukkan pada gambar 4.9. spesimen genteng 

komposit mengalami retak pada bagian tengah diakibatkan struktur genteng yang berserat 

sehingga gaya impak yang diserap oleh genteng tersebut tidak terdistribusi dengan baik. Pada 

ketinggian 1 m genteng komposit mengalami kegagalan pada matriks dengan kedalaman 

patahan hingga 15 mm sesuai dengan tebal genteng tersebut, namun belum mengalami 

kegagalan pada serat. Sedangkan pada spesimen genteng komersil, stuktur genteng yang 

padat, kuat dan getas membuat gaya impak yang diterima lebih besar dan mengakibatkan 

patah. 

(a) 
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(b) 

Gambar 4.10 Patahan pada area impak ketinggian 1 m (a) secara tidak langsung, (b) secara 

langsung. 

Bentuk patahan pada specimen komposit dapat dilihat pada gambar dimana pada area 

impak specimen terlihat bahwa terjadi kegagalan pada matriks namun serat masih belum 

mengalami kegagalan sehingga spesimen tidak langsung putus. Distribusi serat pada gambar 

4.10 (a) yang merupakan bagian samping dari spesimen terlihat kurang merata dimana bagian 

tengah spesimen memiliki lebih banyak serat. 

Spesimen Ketinggi

an (m) 

Teganga

n (MPa) 

Kondisi 

Spesime

n 

Komposit 

A 
0,5 0,00026 retak 

Komposit 

B 
0,5 0,00028 retak 

Komposit 

C 
0,5 0,00028 retak 

Komersil 

A 
0,5 0,00039 patah 

Komersil 

B 
0,5 0,00042 patah 

Komposit 

D 
1 0,00035 retak 

Komposit 

E 
1 0,00035 retak 

Komposit 

F 
1 0,00037 retak 

Komersil 

C 
1 0,00044 patah 

Komersil 

D 
1 0,00044 patah 

5. Kesimpulan dan Saran

Kesimpulan

1. Analisa hasil produk genteng komposit berbahan concrete foam diperkuat serat TKKS

berdasarkan kualitas fisik: 

a. Reduksi berat
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Berat genteng komposit berbahan concrete foam diperkuat serat TKKS berhasil direduksi 

hingga 44,89% dan memiliki berat rata-rata 1,518 kg. 

b. Makrostruktur

Porositas yang terjadi pada permukaan genteng komposit = 49,42% per 100 mm2 dengan 

besar butir rata-rata = 0,008 mm2 dan pada potongan bagian dalam = 62,3% per 100 mm2 

dengan besar butir rata-rata = 0,013 mm2. Maka, rata-rata area porositas pada spesimen 

genteng komposit = 55,86%. 

c. Rembesan air

Dari hasil uji permeabilitas genteng dengan jumlah sampel sebanyak 3 buah yang sudah 

dilapisi dengan cat beton, diperoleh bahwa genteng dari bahan komposit concrete foam 

diperkuat serat TKKS mampu menahan kuantitas air selama 20 jam ± 5 menit tanpa adanya 

kerusakan struktur dan rembesan air. Meskipun tidak terjadi rembesan air namun genteng 

menjadi lembab akibat penyerapan air hingga 62% yang diakibatkan oleh porositas yang 

cukup tinggi pada spesimen. 

2. Hasil pengujian pada genteng komposit ketinggian 0,5 m Fmax = 106,0461 N , Tegangan =

0,00028 MPa dan pada genteng komersil; Fmax = 159,1182 N , Tegangan = 0,00042 MPa. 

Sedangkan pada ketinggian 1 m untuk genteng komposit; Fmax= 141,4602 N, Tegangan 

0,00037 MPa dan pada genteng komersil;; Fmax = 167,9472 N, Tegangan = 0,00044 MPa. 

Kondisi spesimen pada genteng komposit pada ketinggian 0,5 m dan 1 m adalah patah pada 

matriks dan belum patah serat, sedangkan pada genteng komersil pada ketinggian 0,5 m dan 1 

m genteng mengalami patah matriks dan terpisah menjadi beberapa bagian. 

3. Perbedaan pola kerusakan pada genteng komposit dan komersil disebabkan pada genteng

komposit sifat fisisnya berubah menjadi kurang getas dan juga pengaruh serat TKKS sehingga 

tegangan yang masuk pada spesimen dapat diredam sebagian dan tidak langsung 

mengakibatkan patah. Sedangkan pada genteng komersil, struktur yang padat, kuat namun 

getas mengakibatkan spesimen langsung patah ketika dikenai tegangan. 

Saran 

1. Dalam pembuatan spesimen perlu ada  ide-ide agar spesimen tidak rusak sewaktu dibuka

dari cetakan. 

2 Pembuatan genteng komposit  berbahan concrete foam dengan penguat serat TKKS 

diharapkan dapat menjadi acuan dan ide baru dalam menghasilkan berbagai macam produk 

lain dengan bahan  concrete foam. 

3. Diperlukan penelitian lebih lanjut untuk coating pada genteng agar penyerapan airnya

dapat dikurangi. 

4. Diperlukan penelitian lebih lanjut untuk variasi butir pasir agar dapat mengurangi porositas

yang tidak diinginkan pada genteng komposit. 

6. Penghargaan

Pada kesempatan ini penulis mengucapkan penghargaan dan rasa terima kasih kepada Bapak 

Prof. Dr. Ir. Bustami Syam, MSME. (selaku dosen pembimbing; Proyek hibah MP3EI; dan 

tidak lupa juga kepada seluruh Tim Lab. IFRC USU, atas sarana dan fasilitas pengujian, serta 

rekan-rekan mahasiswa baik langsung maupun tidak yang telah membantu penyelesaian studi 

S1 saya ini. 
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